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Introduction

When documents created with Microsoft( Office 2000 are viewed in different Web browsers a number of differences can occur in how the document appears. These differences can be attributed to the way the various browsers support Web technologies such as Hypertext Markup Language (HTML) and cascading style sheets (CSS). As will often be the case, a user might create an Office 2000 document and want to make it available to others on the Web. The user publishes the document to the Web, previews it in their Web browser to make sure that the document appears correctly and then lets people know that it is available. It is quite possible that many of the people who will want to read the document won't have the same browser or browser version as the author.  

How does an Office 2000 document change as it is viewed on different Web browsers?

The table below shows which of the following technologies are supported by the Office 2000 supported browsers: Hypertext Markup Language (HTML), cascading style sheets (CSS), Dynamic Hypertext Markup Language (DHTML), and Extensible Markup Language (XML).  

	 
	HTML 3.2
	CSS 1.0
	CSS 2.0
	DHTML
	XML

	Netscape Navigator 3.02
	Yes
	No
	No
	No
	No

	Netscape Navigator 4.x
	Yes
	Yes
	No
	No
	No

	Internet Explorer 3.02

 
	Yes
	Yes
	No
	No
	No

	Internet Explorer 4.0x
	Yes
	Yes
	Yes
	Yes
	No

	Internet Explorer 5.0x
	Yes
	Yes
	Yes
	Yes
	Yes


Office 2000 allows authors to publish their documents so that they can be viewed using several different browsers. By default, when Office 2000 is installed, several options are set so that documents saved as Web pages can be viewed with the highest possible preservation of formatting in newer browsers. However, these options can be set so that documents saved as Web pages are not optimized for the latest browsers. By changing several of these options, older browsers will display a better-looking Web page and newer browsers may display a slightly less WYSIWEB page  (What You See Is What is Displayed by the Browser). Further discussions concerning these options can be found later in this paper.

Note:  Testing for this paper was performed using Netscape Navigator 3.04, Netscape Navigator 4.05, Netscape Navigator 4.5, Microsoft Internet Explorer 4.72.3110, and Internet Explorer 5.00.0910.1307.  

Integrated Office Features   

Many of the Web features are common to Microsoft Word, Excel, and PowerPoint(.

Inserted Objects 

Office 2000 HTML documents can incorporate numerous objects into documents.  Pictures, word art, movies and other office objects are just a few of the items that can be incorporated. However, Word, Excel and PowerPoint each handle inserting objects in slightly different manner. Office 2000 uses an entirely new method to display graphics in Internet Explorer 5. Office 2000 applications save graphics in Vector Markup Language (VML) format in HTML and Internet Explorer 5 renders the VML directly. VML is not a new graphics format, but rather a syntax for describing vector graphics. Earlier version browsers would render GIF/JPEG images of the graphics that are generated by Office 2000 applications for Web viewing. (VML is a proposed standard for Web graphics that has been submitted to and acknowledged by the World Wide Web Consortium.)

Positioning/Layout of Objects

Word

There are two basic paradigms for inserting objects into an Office 2000 document. The first method treats the object being inserted and the text in the document as if they exist on the same 2-dimensional layer. Following this paradigm, Word will not allow the object being inserted to occupy the same location as text or another object in the document. Three of the text-wrapping options found in Word follow this paradigm. They are in-line, square, and top and bottom wrapping. In-line is the default wrapping option.

The other paradigm allows objects and text to occupy the same space in the XY-plane. In this situation each item lives in a separate layer. These layers can then be organized with relation to the Z-axis (objects in front of or behind each other).  Word uses this option in two text-wrapping options—in front of text or behind text.   

As the table below shows, each of the five browsers tested can correctly position objects when following the first paradigm. However, as the table shows, inserting objects in front of or behind each other causes them to be displayed in unexpected ways depending on the browser.

In addition, when a Word document that is originally optimized for a printed copy is then saved as a Web page, the document changes from a fixed-width page model (Print Layout view) to a variable-width page model (Web Layout view: text wraps to fit the window width). This change can also cause unexpected changes in layout.

	 
	Netscape Navigator 3.04
	Netscape Navigator 4.05
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Inline
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB

	Square*
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB

	Behind Text
	Inline
	Object not visible**
	Object not visible**
	WYSIWEB
	WYSIWEB

	In Front of Text
	Inline
	Object not visible**
	Object not visible**
	WYSIWEB
	WYSIWEB

	Top and Bottom
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB


* Word 2000 produces a warning explaining that in Web view the object will become left or right aligned, and then moves the object in the Word window.  HTML does not have a mechanism for positioning objects arbitrarily on the page and have text wrap around them. Objects can be placed arbitrarily on the page using CSS position, but text is unable to wrap around those objects.  

** This is due to some issues with the Netscape Navigator layout engine. On pages that include CSS positioning, Navigator often fails to render the page correctly.

Excel

Excel follows the second paradigm—objects and text are on different layers. Just as in Word, these objects can be arranged from front to back, however, the text found in the spreadsheet cells is always the bottom layer. Therefore any object positioned in the same XY-plane location will cover up text in the cells in Excel.  Both Internet Explorer 4 and Internet Explorer 5 can allow for overlapping text and objects in the Web page. However, in some situations the Z-positioning will not necessarily be WYSIWEB in Internet Explorer 4. Users of Netscape Navigator 3, 4, and 4.5 browsers will see non-WYSIWEB views of the Excel 2000 generated Web page.  

An HTML table (and in some cases both an HTML table and CSS positioning) is used to display an Excel 2000 spreadsheet that is published as a Web page. When an object is inserted, cells in this table are merged so that the inserted object(s)* fits in one table cell. Column and row sizes are adjusted to fit the object(s) being inserted, which causes the page not to appear as expected.

Note  Trying various text alignments in the cells may improve the appearance of the Web page.

*Overlapping objects are combined to form one image when publishing a spreadsheet to the Web and are placed in one single table cell.

PowerPoint 

PowerPoint also places each object on a separate layer. However, everything on a slide, excluding the background, is considered an object. Because the PowerPoint algorithm for displaying objects is designed for HTML 3 output, which all five browsers can handle, PowerPoint slides should look the same when on the Web. This algorithm preserves Z-positioning except for text boxes that contain selectable text. These text boxes will always appear on top of all other objects in the Netscape browsers.

Background Sound and Movies

Several features from the Office Web toolbar, such as background sound and video, will not work on the earlier browsers. These features are available for both Internet Explorer 4 and Internet Explorer 5 but do not run in the Netscape browsers because they utilize Internet Explorer specific tags (<bgsound src=foo.wav> and <img dynsrc=foo.avi), which are not part of standard HTML.  Netscape browsers will display an alternative picture or alternative text for video if the author has provided one to be displayed. Otherwise, the unloaded picture icon is displayed. 

Pictures

For those users who have image loading turned off on their browsers, or are using a text-only browser, alternative text is shown. This alternative text can be added in Office documents from the Web tab found in the Format Object dialog box.  

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Alternative Text
	Displays one line of text. If text exceeds placeholder, it disappears completely.
	Same as Netscape Navigator 3
	Same as Netscape Navigator 3
	Displays as much of the text as will fit in the picture placeholder.*
	Same as Internet Explorer 4 


*This is the default setting. Internet Explorer 4 and Internet Explorer 5 will display the entire text if the user selects the option Always expand alt text for images. This option is found under Accessibility on the Advanced tab in Internet Options.

Comments

Each of the Office 2000 applications allows for a user to place comments in the documents. Word and Excel have very similar methods of handling this feature.  

Word 2000

	 
	Netscape Navigator 3, 4, 4.5
	Internet Explorer 4, 5

	Indication of Comment
	A hyperlink (reviews initials and comment number) placed directly after commented upon text. Clicking on link takes user to comment section. 
	Same as Netscape Navigator 3, 4 and 4.5, but the hyperlink is placed over yellow background and clicking on the hyperlink does not change viewing location.

	Comment
	Bottom of Web page; Has hyperlink back to commented upon text in the document.
	Pausing (no clicking) over the hyperlink reveals comment.


Excel 2000

	 
	Netscape Navigator 3, 4, 4.5
	Internet Explorer 4, 5

	Comment Indication
	A hyperlink, indicated by the number of the comment inside of bracket, is placed after the cell(s) that the comment is related to.  The internal link will take the user to a footnote section.
	This indicator is a superscript number of the comment inside of brackets. The indicator is much smaller than the indicator found in the Netscape browsers.

	Comment
	The comment is displayed in the following manner:

[1] // a hyperlink to text

Name of Commenter:
Comment
	Pausing (no clicking) over the indicator reveals the comment.


PowerPoint 2000

Comments inserted into a PowerPoint presentation are colored text boxes. These boxes are displayed in the same way in all browsers. However, if the comment is covering text or an object in Netscape browsers, the comment is displayed below the text (even when the order is set to bring to front). Internet Explorer 4 and 5 will place comments in relation to other objects (in front or behind) just as they appear in PowerPoint 2000. However, when a document is saved with the option Internet Explorer or Netscape Navigator 3.0 or later selected, the comment will automatically appear in front of all of the other objects.

Features Specific to Word 2000

Word 2000 contains many features that are not supported by any Web browser available today. However, Word 2000 can be set so that these features are not available to authors when they create Web pages. In this way authors are guaranteed the best visual fidelity when the document is viewed in the browser. (On the Tools menu, choose Options. On the General tab of the Options dialog box click the Web Options button. In the Web Options dialog box, select the Disable Features not supported by checkbox.) With this option selected, users will be notified if they try to use a feature that cannot be reproduced in their Web browsers. If this option is not selected, the unavailable formatting may be ignored or a substitute format invoked. If a document containing formatting not available for the Web is opened while the option is selected, or this option is selected after unavailable formatting has been applied, Word 2000 shows a dialog box that indicates the feature that is unavailable, what will be changed, and the number of times this feature was used in the document.

When creating documents to be saved as Web pages, the user should work in the Web Layout view. This view can be selected from the View menu or from the Web Layout View button on the bottom left of the Word window. 

Font Formatting

Since Netscape Navigator 3 does not support CSS, a great deal of the formatting features available while creating a document in Office 2000 are lost in this browser if the default settings are not changed. Word 2000 has a save option—Rely on CSS for font formatting—that will improve the appearance of a document when viewed in an earlier version browser. With this option selected, a document will be saved as a Web page relying on CSS for font formatting or utilizing HTML and CSS for font formatting. (On the Tools menu choose Options. On the General tab of the Options dialog box click the Web Options button. Select the Rely on CSS for font formatting checkbox.) Utilizing HTML and CSS will improve how Netscape Navigator 3 displays text formatting on the page. The table below shows some font formatting differences seen in the various browsers.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	General: 

Font Face, Color, Size
	Font face, color, and size not preserved with Rely on CSS option selected; Otherwise almost WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB
	WYSIWEB

	Small Caps
	Case not changed
	Case not changed
	Case not changed
	Looks like normal caps
	Looks like normal caps

	Expanded and

Condensed Font Spacing
	Not preserved
	Not preserved
	Not preserved
	WYSIWEB
	WYSIWEB


Some font formatting is not available for Web publications because of browser limitations. When the Disable features not supported by option is selected, Word 2000 indicates when these formats are being utilized before the user saves a document for Web publication. If this option is not selected, several changes might be noticed.

	Formatting Feature
	Changes To

	Double Strike Through
	Single Strike Through

	Words Only Underline
	Single Underline

	Decorative Underlines (Dots, Dashes, Waves)
	Single Underline


Hyperlinks

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Bookmarks 

(Anchors)
	WYSIWEB
	Underlined
	Underlined
	WYSIWEB
	WYSIWEB


Marquee

Marquee text is text that scrolls across the screen. This is an Internet Explorer-specific HTML tag and is not part of standard HTML.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Marquee
	Text shown static at left margin
	Text shown static at left point of marquee field
	Text shown static at left point of marquee field
	Text scrolls properly
	Text scrolls properly


Forms

When the user creates forms using the tools available in the Web Tools toolbar in Word 2000, differences occur from browser to browser.  

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Spacing
	Slightly greater than Internet Explorer 5
	Slightly greater than Internet Explorer 5
	Slightly greater than Internet Explorer 5
	WYSIWEB
	WYSIWEB

	Elements Size
	Slightly larger than Internet Explorer 5
	Larger than Netscape Navigator 3
	Larger than Netscape Navigator 3
	WYSIWEB
	WYSIWEB

	Size of Action Button
	WYSIWEB
	Larger than Internet Explorer 5
	Larger than Internet Explorer 5
	WYSIWEB
	WYSIWEB


Bullets

The table below shows four of the bullets displayed to the user from the Bullets and Numbering dialog box (on the Format menu). When the Rely on CSS for font formatting option is selected, the following substitutions are made and displayed in Netscape Navigator 3. When it is not selected, the bullets show up as they appear in Word. The other browsers display the bullets properly. By selecting the Customize button in the Bullets and Numbering dialog, the user may select any character to be the bullet. When the Rely on CSS for font formatting option is selected, Netscape Navigator 3 will display a substituted character. 

	Bullet
	Netscape Navigator 3
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Tables

The browsers allow for varying degrees of table formatting preservation when Word 2000 publishes a document for the Web. Some table features are not available to Web browsers. These features include decorative border styles (dashed, dots, wavy, barber pole, stripe), diagonal table lines, cell patterns, and text direction. If these are selected, they will be replaced when viewed in Internet Explorer 4 or Internet Explorer 5. Users will be warned when this occurs if they have selected the Disable features not supported by option.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Border Color
	Not preserved; All become gray
	Not preserved; All become gray
	Not preserved; All become gray
	Preserved
	Preserved

	Border Width and Height
	Preserved when Rely on CSS is not selected; Otherwise not preserved
	Width and height preserved if Rely on CSS not selected; Otherwise height sized to text 
	Same as Netscape Navigator 4
	Preserved
	Preserved

	Border Style

 
	All borders become 1 pt.
	All borders become 1 pt.
	All borders become 1 pt.
	Preserved; Double outline becomes 2pt thick border
	Preserved; Double outline becomes 2pt thick border

	Background Colors
	Somewhat preserved*
	Sometimes preserved**
	Sometimes preserved**
	Preserved
	Preserved

	Background Patterns
	Not Preserved
	Preserved
	Preserved
	Preserved
	Preserved

	Table Positioning (Center, Right, Left, Free)
	Free positioning is left justified; Otherwise preserved
	Same as Netscape Navigator 3
	Same as Netscape Navigator 3
	Preserved
	Preserved

	Text Alignment in Cells
	Horizontal preserved; Vertical not preserved 
	Preserved
	Preserved
	Preserved
	Preserved


* In the case that the background color was set for the entire table and then selected cells within the table were changed, these selected cells had backgrounds of the first color set.

** When table is colored entirely same color, color preserved.

Paragraph Formatting

Several differences can be seen with regards to paragraph formatting in Word 2000 output on the browsers. Some formatting applied to paragraphs and text, available in Word 2000, may not be supported by the browsers. These formats will be substituted with similar formatting or the formatting will be ignored. Word 2000 will warn the user that these formats are unavailable if the Disable features not supported by option is selected.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Line Spacing
	Not preserved;

All single spaced
	Preserved
	Preserved
	Preserved
	Preserved

	Paragraph Shading
	Not preserved
	Preserved
	Preserved
	Preserved
	Preserved

	Paragraph Borders
	Not preserved
	Preserved
	Preserved
	Somewhat preserved*
	Somewhat preserved*

	Character Shading
	Not preserved
	Somewhat preserved***
	Same as Netscape Navigator 4
	Preserved
	 Preserved

	Character Boarders
	Not preserved
	Somewhat Preserved***;

New line started after all character borders
	Same as Netscape Navigator 4
	Not preserved
	Not preserved

	Character Patterns
	Not preserved
	Somewhat Preserved***
	Same as Netscape Navigator 4
	Same as Netscape Navigator 4
	Same as Netscape Navigator 4

	Hard Return**
	Double spaced
	Single spaced
	Single spaced
	Single spaced
	Single spaced


* Double paragraphs borders will only show one border around the paragraph.

** A hard return is when the user types the ENTER key to start a new line. The table assumes that paragraph spacing is set to single.  

*** Substitutions will occur for some selections

Frames

In the event that someone creates a frameset containing a single frame for their Web page, the Netscape browsers will show a blank page regardless of the content. Internet Explorer 5 displays the contents of the Web page on a single frame. This is only likely to happen when someone creates a frame page using Word 2000.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Frame Border Colors
	WYSIWEB
	WYSIWEB
	WYSIWEB
	Border sizes less than 3.4 pt. are always black
	Border sizes less than 3.4 pt.  are always black 


Backgrounds

Word allows the user to select a color, picture, pattern or gradient as a background while in Web view. These backgrounds appear in all of the browsers; however, the gradient backgrounds appear significantly less sharp in the Netscape browsers.

Excel 2000

Note About Netscape 4.5 and Excel 2000

At the time of writing, Netscape 4.5 was unable to support Microsoft Excel documents that utilize frames. As a result, when a user attempts to use Netscape 4.5 or 4.5 to view an Excel workbook published to the Web, the browser may crash and exit.  

Fonts

Just as with Word 2000, Excel 2000 can allow authors to publish their documents relying on CSS or using HTML and CSS for font formatting. (On the Tools menu choose Options. On the General tab of the Options dialog box click the Web Options button. Select the Rely on CSS for font formatting checkbox.) Choosing Rely on CSS for font formatting will produce results similar to those in Word 2000.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Color, Size, Font Face
	Not preserved if Rely on CSS option selected; otherwise preserved
	Preserved
	Preserved
	Preserved
	Preserved

	Bold and Italic
	Not preserved if Rely on CSS option selected; otherwise preserved
	Preserved
	Preserved
	Preserved
	Preserved

	Strikethrough, Superscript, Subscript
	Preserved
	Preserved
	Preserved
	Preserved
	Preserved

	Text Alignment
	Preserved if Rely on CSS option is not selected
	Preserved
	Preserved
	Preserved
	Preserved


Cell Properties

Some of the properties of cells such as size and border appear differently depending on the browser.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Borders
	Not preserved
	Not preserved
	Not preserved
	Some preserved; Others not preserved*
	Some preserved; Others not preserved*

	Cell Sizes
	Preserved
	Preserved
	Preserved
	Preserved
	Preserved


* Simple borders for cells are preserved.  More complex cell borders may not show up or be replaced with a simpler border style.

 

Borders

Cell Shading and Patterns

Cell patterns in Excel are not visible in any browser; however, when the Rely on CSS for font formatting option is not selected, colored patterns are seen as cell backgrounds of the same color. If the Rely on CSS for font formatting option is selected, Netscape Navigator 3 will not display any cell backgrounds.

Workbook Navigation

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Work Book Tabs
	Simple frame below worksheet data with tab for each sheet
	Simple frame below worksheet data with tab for each sheet
	Unable to test this feature
	Better looking frame with tabs that change color to indicate current worksheet active. When the pointer is over a tab, the tab changes color. Tab Navigation tools are included.
	Same as Internet Explorer 4


Hidden Columns, Hidden Rows

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Hidden 
Columns
	Still visible
	Still visible
	Still visible
	Hidden
	Hidden

	Hidden Rows
	Still visible
	Hidden
	Hidden
	Hidden
	Hidden


Publishing Using the Interactive Web Components

Excel has a feature that allows the user to publish a spreadsheet and create a document that uses the new Microsoft Office Web Components (comprised of the Spreadsheet, PivotTable(, and Chart components). These components are ActiveX( controls that run in the browser to allow tables to recalculate and charts to update as data is changed, as well providing the ability to use PivotTable views in the browser. ActiveX technologies are not supported in any of the Netscape browsers, so these features do not appear when viewed in any Netscape browser. Web charts, PivotTable views, and interactive worksheets are supported by Microsoft Internet Explorer version 4.01 and later.

PowerPoint 2000

Note About Netscape 4.5 and PowerPoint 2000

At the time of writing, Netscape Navigator 4.5 was unable to support Microsoft PowerPoint documents that utilize frames and were published as Web pages with the All browsers listed above option selected. As a result, when a user attempts to view a PowerPoint document published to the Web using Netscape Navigator 4.5, the browser may crash and exit. 

Publishing Options

PowerPoint allows users to save a presentation for the Web optimized for Internet Explorer 4.0 or later (high fidelity), saved for Internet Explorer or Netscape Navigator 3.0 or later, or the document may be saved in both formats (creates larger files but can be seen by both earlier and later version browsers). The default setting for publishing a PowerPoint presentation to the Web is optimized for Internet Explorer 4.0 or later.

High Fidelity Web Publication

As expected, when PowerPoint publishes a presentation to the Web and the Microsoft Internet Explorer 4.0 or later (high fidelity) option is selected, Netscape Navigator 3, 4, and 4.5 will not display the presentation. Instead, these browsers will show the user the expanded Outline view of the associated presentation. 

Slide Transitions 

Slide transitions occur when a slide is shown on the screen.   

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Functionality
	Transitions not viewable
	Transitions not viewable
	Transitions not viewable
	Viewable*
	Viewable*


* Slide transitions are easily viewed in full screen mode; however, transitions in regular view can be difficult to see.

Viewing and Layout of PowerPoint HTML Files in Browsers

There are several features that differ between the browsers while viewing and manipulating a slide presentation on the Web. When the user publishes a presentation for all browsers here are some differences.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Slide Size
	Static**
	Static**
	Static**
	Dynamic***
	Dynamic***

	Outline Control

Expand/Contract
	Two separate buttons
	Two separate buttons
	Two separate buttons
	One button performs both functions*
	One button performs both functions*

	Slide Navigation

Outline View****
	No high-lighting
	No high-lighting
	No high-lighting
	Highlighting*
	Highlighting*

	Hide/Show Outline
	Not available
	Not available
	Not available
	Available*
	Available*

	Full Screen Show
	Not available
	Not available
	Not available
	Available*
	Available*

	Resizable Frames
	No
	No
	No
	Yes
	Yes


* Please note that these features are not available if the presentation is published with the Internet Explorer or Netscape Navigator 3.0 or later option selected.

** The static slide size can cause an extra all black frame to be visible below the slide and above the slide control frame when the browser window is maximized.    

*** This only occurs when the Resize graphics to browser window option is selected. This option is found on the General tab of the Web Options dialog box.

**** The side navigation frame can be chosen not to show by deselecting this option. This option is found on the General tab of the Web Options dialog box.

Show Notes

The Show speaker notes option is handled best by Internet Explorer 4 and 5.  They display the notes along with a button, located next to the Previous Slide button, to hide the speaker notes. [The notes do not necessarily display in the size that the user indicates but the font is proportional to other fonts in the Speaker Notes section]. In several situations Netscape Navigator 3, 4 and 4.5 have problems displaying the notes sections (since the Netscape browsers are unable to dynamically resize frame). The ability to clearly see speaker notes in the Netscape browsers is dependent upon two settings. The first setting is the Screen size of the target monitor. This option is found on the Pictures tab in the Web Options dialog box (Tools/Options) of PowerPoint. The author of the document should select this setting. The second setting is found on the machines used by the audience to view the presentation. This option is the Screen area setting of Windows.* This is a difficult problem to correct because in most situations the author will not know the operating system setting of his audiences.

* To change the screen area: Click the Start button, point to Settings, and choose Control Panel. Double-click Display. On the Settings tab move the slider in the bottom right of the dialog box.

Tables

In most cases, tables in PowerPoint presentations can be viewed in all the browsers with equal clarity. Cell backgrounds, fill patterns, and border styles are preserved in all of the browsers tested; however, there are some examples where tables containing text do not look correct in Netscape Navigator 3, 4, and 4.5.   This can occur when the font used is not available in the browser. 

Bullets

Bullets in PowerPoint presentations are displayed slightly differently depending on the browser.

	 
	Netscape Navigator 3
	Netscape Navigator 4
	Netscape Navigator 4.5
	Internet Explorer 4
	Internet Explorer 5

	Oversized bullets (>100%)
	Reduced to normal size
	Reduced to normal size
	Reduced to normal size
	Seen as oversized
	Seen as oversized


Slide Designs

Some slide designs will be displayed differently in the various browsers. An example of this is with the notebook design. Internet Explorer 5 shows the individual notebook sheet; however, the Netscape browsers show this image tiled, exposing portions of other sheets of paper. 

Conclusion

This document cannot possibly contain every variation of how browsers will display the same Office 2000 document. As with every Web page created, users will achieve best results by knowing which browsers their audiences use and by viewing their pages on as many of these Web browsers as possible. In order to improve the audience experience, authors of office 2000 documents who plan to publish them as Web pages should be mindful of the differences in display characteristics that their audiences are likely to see.


The information contained in this document represents the current view of Microsoft Corporation on the issues discussed as of the date of publication. Because Microsoft must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Microsoft, and Microsoft cannot guarantee the accuracy of any information presented after the date of publication.

This document is for informational purposes only. MICROSOFT MAKES NO WARRANTIES, EXPRESS OR IMPLIED, IN THIS DOCUMENT.
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